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Prefazione

Un manuale d’uso approfondito, che sia come in questo caso relativo a un software o a 
una qualsiasi altra cosa, riveste un ruolo talmente grande da rivelarsi importante tanto 
quanto il software stesso. 
Favorire la comprensione delle molteplici funzionalità, indicare le scorciatoie per rag-
giungere presto e bene la meta, creare un percorso chiaro per muoversi nella miriade 
di funzioni è cruciale affinché il software possa diventare uno strumento potentissimo 
al servizio della creatività e della fantasia di ognuno.
Luca Bimbi racchiude in sé da un lato la competenza specifica, direi scientifica, indi-
spensabile a penetrare e sviscerare l’argomento trattato, il senso d’urgenza e le pre-
tese – in quanto lui stesso fine utilizzatore – e dall'altro il rigore formale affinché la 
chiarezza vinca sempre anche sull’argomento più ostico.
Non ultima la grazia dell’anima che abita i creativi, gli artisti e gli uomini di pensiero.

In bocca al lupo!

Luciano Luisi 
Produttore Artistico
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Introduzione

Apple ha lanciato l'ultima versione di Logic Pro nell’estate del 2013. Si tratta della ver-
sione X, lungamente attesa dagli utenti.
Fra le novità, spiccano soprattutto una nuova interfaccia, gli Smart Controls, i MIDI FX 
(con particolare riguardo al potente arpeggiatore), il Flex Pitch, l’Audio Track Editor, 
l’Arrangement Track e un nuovo tipo di traccia, Drummer, che mette a disposizione 
dell’utente un vero e proprio batterista virtuale intelligente.
Questa nuova edizione del libro copre le modifiche e le funzionalità aggiunte alla ver-
sione corrente nel momento della redazione del testo, ossia la 10.2.4. Alcuni argomen-
ti particolari, che non possono essere affrontati nel presente libro, saranno introdotti 
nei contenuti online via via resi disponibili sul sito www.lucabimbi.net. 
Questo libro è il prodotto della mia esperienza di insegnamento presso il Modern Mu-
sic Institute di Sarzana (SP). È rivolto in particolar modo a chiunque si avvicini per la 
prima volta alla produzione musicale con il computer. Il testo, comunque, è altresì 
adatto a chi abbia precedenti esperienze, anche su piattaforme diverse.
La terminologia utilizzata per la definizione di alcune parti della Arrange Window ri-
calca, per lo meno nella parte iniziale, quella della versione 9 di Logic Pro, sebbene sia 
affiancata da quella introdotta con la versione X. Ciò è stato fatto perché ritengo che 
distinguere un’area di arrangiamento e una lista delle tracce, all’interno della Tracks 
area, possa essere più chiaro e favorisca la comprensione dei meccanismi di produ-
zione musicale mediante questo potente software. Soprattutto per ciò che riguarda il 
mixaggio e l’automazione, la trattazione non può essere assolutamente completa (ciò 
richiederebbe un testo a parte), ma è certamente adeguata a introdurre gli argomenti 
più importanti.

Cosa troverete in questo libro
Questo testo tratta tutti gli argomenti collegati con la produzione musicale in Logic 
Pro X: dai concetti generali, espressi in maniera elementare ed essenziale (digitalizza-
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zione di un segnale analogico, MIDI eccetera), alla configurazione del computer e di 
Logic Pro X, passando per l’analisi degli elementi della Arrange Window, del proget-
to, dell’uso e della creazione di Apple Loops, dell’arrangiamento con la Arrangement 
Global Track, della registrazione audio e MIDI, dell’editing audio e MIDI, dell’utilizzo 
di Drummer, del Mixer, delle automazioni e dell’esportazione del materiale musicale 
creato.
Per chi voglia condividere con altri le proprie creazioni durante la lettura del libro, si 
consiglia di dare un’occhiata fin da subito all’ultimo capitolo. La stesura del testo pre-
suppone che il libro venga comunque letto per intero, secondo l’ordine dei capitoli 
proposti. Ogni capitolo include un’esercitazione, per facilitare la memorizzazione dei 
concetti introdotti e diversi esempi pratici.
Il manuale non presuppone che l’utente abbia scaricato l’intera libreria dei contenuti 
aggiuntivi di Logic Pro X, escluso il Producer Kits SoCal per chi sia interessato ad ap-
plicare i concetti del paragrafo corrispondente nel Capitolo 8. Per chi volesse scarica-
re contenuti aggiuntivi, questi sono disponibili dal menu Logic Pro X>Sound Library. 
Particolarmente pratico è il Sound Library Manager (Logic Pro X>Sound  Library> 
Open Sound Library Manager), che consente di selezionare nel dettaglio i contenuti 
desiderati. Nella Library e nella Apple Loop Library, comunque, sono disponibili dei 
bottoni di download (freccia in basso cerchiata). 
I progetti Logic Pro X collegati al testo sono scaricabili dal sito web www.lucabimbi.net. 
Periodicamente saranno aggiunti nel sito web nuovi progetti e articoli, che consenti-
ranno di approfondire alcune tematiche affrontate nel libro.
Per chi volesse comunicare con me, sono rintracciabile su Facebook all’indirizzo  
www.facebook.com/luca.bimbi.fanpage.

Ringraziamenti
Desidero ringraziare la casa editrice per la fiducia accordatami, Marco Aleotti per il 
prezioso aiuto datomi, Kathinka Pasveer (www.karlheinzstockhausen.org), Alex Stor-
nello e Gianluca Cagnoli del Modern Music Institute per la stima e il supporto, Andrea 
Negrinelli della divisione Pro Audio di Backline Srl (www.backline.it), Gregory Scott di 
Kush Audio / Sly-Fi Digital (www.thehouseofkush.com www.slyfidigital.com), Rudolfs 
Putnins di Sonarworks (www.sonarworks.com), Gian Guido Zurli, BuyDifferent.it,  
Ron Foos, Marguerite Steele e la magnifica cantante Pascale Elia.
Un ringraziamento particolare va alla mia famiglia per avermi supportato in tutti que-
sti anni.
Questo libro è dedicato ai miei genitori Piera e Luigi, a mio fratello Marco, Marian, 
Jack, Paolino e alla memoria di Jimi.
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Introduzione

Una dedica particolare va a Luciano Luisi, grandissimo produttore artistico e musicista 
dalla sensibilità e intelligenza artistica assolutamente non comuni, a cui devo molto.

“Because the sound waves penetrate very deeply into our molecular and atomic layers,
whenever we hear sounds we are changed. We are no longer the same after hearing 
certain sounds, and this is especially the case when we hear organised sounds - sounds  
organised by another human being: music.”

K. Stockhausen, dal film: Four Criteria of Electronic Music, Oxford, May 6th 1972
(© Stockhausen Foundation for Music, Kürten, www.karlheinzstockhausen.org)





Nozioni preliminari

1

In questo capitolo forniremo alcune nozioni essenziali  
riguardo la conversione di un segnale audio in digi-
tale, il protocollo MIDI, il flusso di lavoro e le simi-
litudini con il modo di lavorare in analogico. 

Le nozioni fornite in questo capitolo sono dirette soprattutto a chi non ha precedenti 
esperienze di lavoro con la registrazione audio digitale, il MIDI e il Digital Audio Work- 
station, tipo Logic Pro X. 

Nozioni essenziali di conversione di un segnale audio 
analogico in digitale
Un suono, rappresentato come un segnale audio analogico, è un insieme di segnali 
elettrici variabili in funzione del tempo. Questi segnali possono essere riportati nel 
mondo digitale, attraverso l’assegnazione di una serie di numeri binari. Il processo che 
caratterizza questo passaggio è chiamato processo di conversione. La conversione fa 
in modo che un segnale audio analogico continuo possa essere convertito in un segna-
le digitale definito, propriamente detto “discreto”.
Per fare ciò, si ricorre alla tecnica del campionamento (sampling) e di questo processo 
si occupa un convertitore analogico-digitale (A/D). In seguito, un altro convertitore 
(D/A) provvederà alla riconversione del segnale digitale in analogico.
In questo libro tratteremo solo la conversione A/D, legata alla problematica della re-
gistrazione audio. 

15
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Frequenza di campionamento
Nella tecnica del campionamento, si compie un determinato numero di misurazioni 
del voltaggio di un segnale elettrico, nell’unità di tempo di un secondo. La quantità di 
misurazioni effettuate nell’unità di tempo identifica la frequenza di campionamento 
(sampling rate), espressa in Hertz (Hz) o suoi multipli (Kilohertz, KHz). 
Il Teorema di Nyquist-Shannon ci dice che, per ottenere una conversione non am-
bigua di un certo segnale, la frequenza di campionamento deve essere almeno due 
volte superiore alla frequenza massima da campionare. Ciò significa che, nel caso di 
sampling rate a 44,1 KHz, la frequenza massima campionata è di 22,05 KHz. Questa 
frequenza è detta Frequenza di Nyquist. Sarà necessario, quindi, un particolare fil-
tro (detto filtro di Nyquist o filtro anti-aliasing), che blocchi le frequenze superiori 
a quella di Nyquist, per evitare distorsioni del segnale digitalizzato. Se, per esempio, 
per una frequenza di campionamento di 44,1 KHz passa oltre la frequenza di Nyquist 
un’armonica a 40 KHz, si creerà una distorsione a 44,1 KHz-40 KHz=4,1 KHz, cioè un 
artefatto nello spettro udibile. Tale tipo di distorsione è detta Aliasing.

Risoluzione
La profondità di bit (Bit depth) costituisce la risoluzione del segnale. Per risoluzione si 
intende il numero di bit assegnabili al segnale da convertire, in funzione delle caratte-
ristiche del convertitore. Per la codifica del segnale in un numero finito di bit, si usano 
dei Livelli di quantizzazione.
Facciamo un esempio particolarmente intuitivo. Si pensi a una scala graduata, come 
per esempio un righello. Più alto è il numero di livelli di quantizzazione, maggiore è la 
risoluzione. È come dire che una certa misurazione è più precisa se, invece di avere 
come unità di misura i decimetri, abbiamo i centimetri o i millimetri.
Con un Bit depth uguale a 8, si hanno 28=256 livelli di quantizzazione. Una registrazione 
a 16 bit ha 216=65.536 livelli di quantizzazione e, infine, una a 24 bit ha 224=16.777.216 
livelli di quantizzazione. All’aumentare del Bit depth corrisponde un aumento dell’in-
tervallo dinamico. L’intervallo dinamico teorico espresso in dB è sei volte il Bit depth. 
Per 8 bit, l’intervallo dinamico sarà quindi 48 dB; per 16 bit sarà di 96 dB; per 24 bit 
sarà di 144 dB. Maggiore è l’intervallo dinamico, migliore è il rapporto segnale/rumo-
re. Durante la digitalizzazione di una grandezza fisica, l’arrotondamento che si ha fra 
il segnale analogico e il livello di quantizzazione, in un dato punto, è detto errore di 
quantizzazione. Tornando all’esempio del righello, se un punto è più vicino a un centi-
metro piuttosto che a un altro, se non ho a disposizione una risoluzione di misurazione 
maggiore, arrotonderò al centimetro più vicino. Se, invece, ho a disposizione i millime-
tri, l’errore da arrotondamento sarà minore, perché potrò approssimare la misurazione 
secondo una scala più fine.
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Figura 1.1 – Da sinistra a destra: il segnale analogico (curva blu) è digitalizzato con crescente Bit depth 
(in verticale) e maggiore sampling rate (in orizzontale). Una più alta risoluzione permette una migliore 
rappresentazione dell’ampiezza della forma d’onda nel segnale discreto, per mezzo di maggiori 
livelli di quantizzazione (cioè una più accurata rappresentazione del segnale analogico continuo). Di 
conseguenza, un sample rate più elevato contribuisce a una migliore corrispondenza fra il segnale 
analogico e quello digitalizzato, consentendo di digitalizzare frequenze più elevate. Si noti la presenza di 
errori di quantizzazione, ossia gli arrotondamenti dati dalla differenza fra il segnale analogico continuo 
e quello digitale discreto.

Logic Pro X e registrazione audio digitale:  
alcuni consigli pratici
Logic Pro consente di registrare a 16 o 24 bit, con frequenze di campionamento che 
vanno da 44,1 KHz a 192 KHz. 16 bit e 44.1 KHz corrispondono alla qualità di un CD 
Audio, mentre fino a 24 bit e 192 KHz corrispondono alla qualità massima di un DVD 
Audio. Per i motivi che abbiamo visto, anche per la produzione di musica in “qualità 
CD” si consiglia il ricorso a 24 bit per sample. I 16 bit, infatti, costringerebbero l’uten-
te a stare più vicino possibile al punto di distorsione (il cosiddetto “zero della scala 
digitale”, o 0 dbFS), per massimizzare l’intervallo dinamico e migliorare il rapporto 
segnale/rumore. Questa necessità non si presenta con la registrazione a 24 bit, grazie 
al più elevato numero di livelli di quantizzazione. Se si “eccede” lo zero (fenomeno del 
Clipping), si ha la distorsione digitale; è un evento da evitare poiché, a differenza della 
distorsione analogica, produce un suono particolarmente sgradevole. 
Si suggerisce quindi di registrare sempre a 24 bit. Si vorrà in ogni caso evitare la di-
storsione digitale. Possiamo, a 24 bit, lasciare spazio per picchi improvvisi nell’audio. 
Si consiglia di regolare il livello di guadagno, in funzione delle parti di un brano suonate 
con maggiore intensità dinamica. Quando, poi, si registrerà, è tendenza naturale quel-
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la di suonare con maggiore intensità. Per questo motivo, è una buona idea, una volta 
provato e trovato il livello di guadagno ideale, abbassarlo un poco, prima di procedere 
con la registrazione. Si vedranno, al momento opportuno, le opzioni di Logic Pro da 
usare per la conversione nel formato finale necessario (per esempio 16 bit e 44,1 KHz 
per un CD Audio). Per il momento, si forniranno solo alcuni elementi teorici essenziali. 

Conversione di sample rate
Un suono campionato, a una certa frequenza di campionamento, può essere portato a 
una frequenza di campionamento diversa, superiore o inferiore. Convertire un sample 
rate in una frequenza di campionamento inferiore è un processo detto di Downsam-
pling; l’inverso è chiamato Upsampling. Nel procedimento di downsampling (quello 
che a noi interessa maggiormente), il processo deve assicurare che siano filtrate le fre-
quenze non rappresentabili alla frequenza di campionamento di destinazione, affinché 
non si infranga il teorema di Nyquist-Shannon, per evitare l’introduzione di distorsione 
da aliasing nel segnale. 

Conversione di Bit depth. Dithering e Noise shaping
Il problema della conversione di Bit depth che più preoccupa, ai nostri fini, è quello 
del passaggio a una risoluzione più bassa di quella di partenza: in particolar modo, il 
passaggio da 24 bit a 16 bit (per esempio per masterizzare un CD Audio). Eliminando 
meramente gli ultimi 8 bit del segnale a 24 bit, si ha un deterioramento dell’audio che 
risulta del tutto sgradevole, soprattutto a causa della compromissione del segnale a 
dinamica soffice. Questo fenomeno è detto anche fenomeno di troncatura. Per ovviare 
a tali problematiche, si ricorre al Dithering.
Il Dithering prevede la sostituzione dell’ultimo bit della risoluzione di destinazione con 
un numero casuale, che è percepito come rumore. La soglia del rumore del dither è, 
quindi, pari a quella dell’ultimo bit della risoluzione, che equivale, nel caso di 16 bit,  
a –96 dBFS.
La tecnica di Noise shaping fa in modo che il rumore, nel caso di cambiamento di riso-
luzione, sia spostato verso aree dello spettro meno udibili dall’orecchio umano. Logic 
Pro X fornisce algoritmi di Dithering e Noise shaping, nelle funzioni di esportazione: 
POW-r #1, POW-r #2, POW-r #3 e UV22HR. È anche possibile utilizzare dei plug-in di 
terze parti, sullo stereo output del mixer, che incorporino Dithering o Noise shaping e 
disattivare tali funzioni in Logic Pro X. 
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Audio PCM, formati compressi con perdita di dati e lossless
La conversione di un segnale analogico in digitale che abbiamo appena descritto è det-
ta PCM (Pulse Code Modulation). I formati PCM utilizzabili ed esportabili da Logic Pro 
X sono AIFF, WAVE e CAF. Nel Capitolo 2 si forniranno alcuni dettagli circa le diffe-
renze pratiche fra tali formati di file audio. Logic Pro X consente inoltre di lavorare con 
formati compressi, quali MP3 e AAC oppure M4A. I formati compressi MP3 e AAC 
comportano una perdita di dati audio, secondo una particolare codifica. I lossless, 
come l’M4A, invece, sono formati compressi che non comportano perdita di dati. La 
codifica per i formati compressi avviene secondo un bit rate specificato dall’utente. Più 
alto è il bit rate, migliore sarà la qualità audio risultante. Vi è la possibilità di ricorrere 
all’opzione VBR (Variable Bit Rate), che cambia il bit rate impostato, in base ai dati 
audio da convertire, per ottenere il miglior risultato possibile. Per “bit rate” si intende 
la quantità di dati audio non filtrati ogni secondo. Per i formati compressi, per essere 
più precisi, il bit rate indica il numero di bit al secondo che viene ricreato dal DAW. 
In un file MP3 codificato a 320 Kbps, per ogni secondo di musica vengono occupati 
320.000 bit nell’MP3 stesso, cioè 40 kilobyte (320.000/8). Un brano da tre minuti e 
mezzo occuperà quindi 40 KB x 210 secondi = 8.400 KB, cioè 8,4 MB. 

N
O

T
A Se si utilizza il VBR, non sarà possibile prevedere la dimensione finale del file, 

finché questo non sarà stato codificato. 

MIDI
MIDI è un acronimo che sta per Musical Instruments Digital Interface e costituisce 
uno standard, reso pubblico nel 1983 e realizzato dalle maggiori case produttrici di 
strumenti elettronici dell’epoca. Ciò non è altro che la risposta al problema della inter-
comunicazione fra strumenti musicali elettronici di diversi produttori. A questo fine, 
fu creato un protocollo di comunicazione: il MIDI. Gli strumenti musicali sono fisica-
mente collegati fra loro, per mezzo di tre tipi di connettori: 

1. MIDI IN, consente al dispositivo di ricevere dati;
2. MIDI OUT, consente al dispositivo di trasmettere dati;
3. MIDI THRU, consente di ritrasmettere i dati ricevuti dalla porta MIDI IN verso 

un diverso dispositivo.

Il protocollo è costituito da “comandi”, detti messaggi, interpretati dagli strumenti 
elettronici. I messaggi sono inviati dal dispositivo trasmittente al ricevente in modo 
seriale, quindi consecutivamente, uno dopo l’altro. Se premo un accordo su una ta-
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stiera MIDI, per esempio una triade di DO Maggiore, le tre note, anche se in teoria 
suonate contemporaneamente, saranno inviate come messaggi MIDI in maniera se-
quenziale. Uno dei messaggi fondamentali, che compongono il “vocabolario” MIDI, è 
NOTE ON, che comunica l’inizio di una nuova nota, insieme alla velocità di attacco, 
che ne determina la dinamica (velocity). Tale valore di dinamica è compreso fra una 
serie di numeri, che varia da 0 a 127. Al termine della pressione che ha determinato 
l’invio di NOTE ON, è inviato un messaggio NOTE OFF. Analogamente ai valori di ve-
locity, la nota premuta è identificata attraverso un numero, compreso fra 0 e 127. Una 
tastiera di pianoforte a 88 tasti comprende note MIDI, che vanno dalla numero 21 (A-1, 
con DO di mezzo C3) alla numero 108 (C7, con DO di mezzo C3). Il DO di mezzo è la 
nota numero 60. La comunicazione dei messaggi avviene tramite 16 canali per con-
nessione. Sarà cura dell’utente specificare attraverso quale canale la comunicazione 
dei messaggi MIDI debba avvenire o impostare la periferica MIDI, affinché risponda 
a tutti i dati in entrata da qualunque canale (modalità OMNI). Esistono vari messaggi 
MIDI, ma possiamo limitarci a parlare dei più importanti:

1. NOTE ON, NOTE OFF, Pitchbend;
2. Controlli Continui.

Figura 1.2 – Rappresentazione di eventi nota nel Piano Roll di Logic Pro X. Le note sono riportate sullo 
schermo come barrette. A colori diversi corrisponde una diversa velocity: dal blu (velocity minore), 
passiamo per il verde (velocity media) e arriviamo al rosso (velocity elevata). In orizzontale è riportato 
il tempo, in verticale il tono. 
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Il controllo di Pitchbend è usato per “stirare” il tono delle note. Sostanzialmente, pre-
mendo su una tastiera MIDI la nota DO e muovendo il controllo di Pitchbend verso 
l’alto, si può ottenere una nota più alta (per esempio il RE), con effetto di glissando.  
Se muoviamo il Pitchbend verso il basso, otteniamo una nota più bassa (per esempio 
il SIb), sempre con un glissando. 
I Controlli Continui (CC) racchiudono tutti i dati che non hanno messaggi specifici. 
Fra i più usati ricordiamo il pedale del sostenuto (sustain pedal, CC numero 64), la 
modulation wheel (CC numero 1) e il volume (CC numero 7).
Vi sono, infine, dei messaggi MIDI detti SYSEX, o System Exclusive, che sono controlli 
esclusivi di sistema, variabili secondo la periferica MIDI. Ogni produttore definisce dei 
SYSEX per ciascun prodotto. L’uso più comune dei SYSEX, probabilmente, è il trasfe-
rimento e la copia di patch verso un sequencer o altro software, ai fini di backup, e la 
possibilità di richiamare tali patch sullo strumento MIDI in un successivo momento. 

Risoluzione MIDI
Facciamo qualche cenno alla risoluzione MIDI. Logic Pro X ha una risoluzione di 960 
PPQN (Pulses Per Quarter Note). Si hanno, cioè, 960 suddivisioni temporali nello 
spazio di una semiminima. La risoluzione MIDI è, quindi, dipendente dal tempo del 
progetto. Si pensi a tali suddivisioni in maniera analoga ai livelli di quantizzazione nella 
digitalizzazione di un segnale analogico. Queste suddivisioni sono chiamate ticks da 
Logic Pro X. Ogni evento MIDI registrato è, quindi, riportato nel tempo secondo tale 
risoluzione e ogni evento sarà posto nella griglia di risoluzione, approssimando alla 
suddivisione più vicina. In sostanza, gli eventi MIDI sono sempre “quantizzati”, ancor 
prima che si ricorra alle funzioni di quantizzazione di Logic Pro X. Per un tempo di  
60 bpm (beats per minute), 960 ticks nello spazio di una semiminima costituiscono, 
in un secondo, una risoluzione inferiore rispetto agli stessi 960 ticks per un tempo di 
120 bpm, nello stesso arco di tempo. A 120 bpm, avendo la semiminima una durata 
dimezzata rispetto a 60 bpm, si ha il doppio di ticks in un secondo, cioè 1.920 invece 
di 960. 
Un tempo, i sequencer MIDI avevano una risoluzione assai inferiore e ciò portava alla 
sensazione di “rigidità” delle parti MIDI registrate. Un trucco valido per aumentare, 
di fatto, la risoluzione MIDI è impostare il tempo del progetto come doppio, rispetto 
all’effettivo, ed eseguire le parti con feeling di tempo dimezzato. 

GENERAL MIDI
È uno standard introdotto nel 1991 e revisionato nel 1999. Per i nostri fini, basta sapere 
che lo scopo dello standard GENERAL MIDI (GM) è quello di definire un modello per 
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gli strumenti MIDI, che supportano tale protocollo (in termini, per esempio, di polifo-
nia ammessa o della necessità degli stessi di rispondere alla velocity), e classificare un 
insieme di strumenti standard, selezionabili per mezzo del messaggio MIDI program 
change. Gli strumenti che si possono scegliere in questo modo sono 128, con valori 
che vanno da 0 a 127. Secondo lo standard GENERAL MIDI, il canale 10 è riservato 
agli strumenti percussivi. La mappatura cromatica degli strumenti percussivi è definita 
dallo standard. Si ha, per esempio, la grancassa 1 (Kick Drum 1) assegnata alla nota 36 
(DO1), il rullante 1 (Snare Drum 1) assegnato alla nota 38 (RE1), il charleston chiuso 
(Closed Hihat) alla nota 42 (FA#1), il crash 1 (Crash Cymbal 1) alla nota 49 (DO#2) 
e così via. Lo standard GM, inoltre, definisce i numeri per alcuni controlli continui. Nel 
caso di quelli visti da noi, 1 per la modulation wheel, 7 per il volume e 64 per il pedale 
del sostenuto. Lo scopo è quello di consentire la compatibilità di lettura e riproduzione 
di brani MIDI tra diversi generatori di suoni MIDI.

MIDI File
Il formato Standard MIDI File è stato creato per condividere dati MIDI in formato file. 
La loro dimensione ridotta ha favorito la facile condivisione e l’utilizzo su dispositi-
vi, come cellulari o floppy disk, e su Internet. I MIDI File possono contenere, come 
metadati, il testo della canzone e ciò ne consente l’utilizzo per i sistemi di karaoke. Il 
formato è stato introdotto nel 1986 dalla Opcode Systems, ma è stato poi standardiz-
zato dal MIDI Manufactures Association (MMA) nel 1988. Da MMA lo standard è 
tuttora mantenuto. Il MIDI File è composto da due blocchi: l’Header chunk e il Track 
chunk. L’Header chunk contiene le impostazioni generali del brano, mentre il Track 
chunk contiene tutti gli eventi MIDI. Gli eventi MIDI sono temporalmente registrati 
secondo la differenza fra un evento e il successivo (sistema di valore temporale detto 
DELTA-time). Esistono tre formati di MIDI File:

1. Formato 0;
2. Formato 1;
3. Formato 2.

Il Formato 0 è limitato alla gestione di una singola traccia. Nel caso, quindi, di un brano 
registrato su più tracce, queste non sono rappresentate separatamente nel MIDI File. 
Tutto sarà incluso in una sola traccia. A canale diverso saranno assegnati eventi diver-
si, per garantire il playback di parti separate.
Il Formato 1 consente di gestire più tracce, che hanno lo stesso valore di tempo e metro. 
Il Formato 2, invece, gestisce tracce multiple come il Formato 1, ma ciascuna traccia è 
indipendente e può avere valori propri di tempo e metrica. 
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I Formati 0 e 1 sono i più usati dai sequencer MIDI. 
Logic Pro X permette di importare file MIDI nel progetto corrente dal menu 
File>Import>MIDI File, e di esportare file MIDI ricorrendo alla funzione 
File>Export>Selection as MIDI File (tasto di scelta rapida, ALT-CMD-E). 

Il flusso di lavoro in Logic Pro X e le similitudini  
con il mondo analogico
In Logic Pro X si ricorrerà al seguente flusso di lavoro: si produrrà un certo materiale 
musicale – o si riutilizzerà del materiale musicale esistente –, si procederà con l’arran-
giamento, per poi passare al mixaggio e, infine, all’esportazione di tale materiale in un 
formato audio (per esempio MP3 o WAVE), oppure MIDI. 
Il materiale, così come per la registrazione su nastro magnetico, sarà organizzato in 
diverse tracce. Per la vostra produzione musicale potrà essere utilizzato del materia-
le preesistente. Si pensi al caso degli Apple Loops. L’arrangiamento avverrà tramite 
il ricorso alle regioni, di cui si parlerà più avanti. Per ora basta sapere che le regioni 
sono dei “contenitori” di materiale musicale, rappresentati graficamente come bar-
rette. Agendo su tali barrette, possiamo organizzare il materiale musicale e, quindi, 
arrangiare il pezzo in modo semplice e intuitivo.
A ogni traccia creata corrisponderà un cosiddetto Channel strip. Ogni traccia avrà, 
cioè, i propri controlli sul mixer. È come se a ogni traccia di una registrazione multipi-
sta analogica si facesse una connessione su un canale di un mixer. Tale connessione 
è virtuale, all’interno di Logic Pro X, a differenza del mondo analogico, dove si deve 
materialmente provvedere al cablaggio. L’esportazione consentirà, poi, di condivide-
re la nostra creazione, in uno dei formati standard. Sarà quindi possibile, per mezzo 
dell’esportazione, rendere il nostro lavoro ascoltabile da altre persone, senza che ne-
cessariamente queste posseggano una copia di Logic Pro. È come se, dalla registra-
zione multitraccia, si facesse una copia del mixaggio su una cassetta, perchè venga 
ascoltata da chiunque possegga un “mangianastri”.

Avvertenze
Il presente libro necessita una copia di Logic Pro X installata sul proprio Mac. Qua-
lora non si abbia una copia di Logic Pro X, l’applicazione è facilmente acquistabile 
per mezzo dell’Apple Store. Completato l’acquisto, Logic Pro X sarà automaticamente 
scaricato via Internet e installato sul vostro sistema. Alla prima apertura dell’appli-
cazione, il programma eseguirà il download di contenuti aggiuntivi. Il libro di testo 
dà per scontato che si utilizzi almeno la versione 10.2.4 del software (la più recente 
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al momento della scrittura del libro) e che sia impostato il preset di Key Command 
Italiano. Assicurarsi, quindi, che Italian sia selezionato dal menu Logic Pro X>Key 
Commands>Options>Preset.
I progetti utili alla miglior comprensione delle esercitazioni sono disponibili per il 
download sul sito www.lucabimbi.net.

Figura 1.3 – Selezione del preset Key Command Italian dal menu Logic Pro X>Key Commands> 
Options>Preset.

Esercitazione: quesiti legati alle nozioni introduttive
Al termine di ogni capitolo, sarà presente un paragrafo, il cui contenuto è utile a fis-
sare nella mente i concetti appresi. A partire dal Capitolo 3, le esercitazioni saranno 
prevalentemente pratiche. Per questo capitolo introduttivo e per il prossimo, ci limi-
teremo a formulare qualche domanda. Il lettore dovrà cercare la risposta nei paragrafi 
precedenti.

1. Che cosa sono la frequenza di campionamento e la risoluzione? 
2. Che cosa si intende per “errori di quantizzazione”?
3. Come regolare il livello audio che arriva al convertitore? Quali accorgimenti è 

bene seguire?
4. Parlare dell’importanza del Dithering e del Noise shaping.
5. Quanto spazio su disco occuperà un MP3 codificato a 128 Kbps della durata di 

2 minuti e 37 secondi?
6. Quali sono i principali messaggi MIDI? Su quanti canali per connessione avvie-

ne la comunicazione, secondo il protocollo?
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7. Quanti ticks si hanno in un secondo per un tempo di 180 bpm e una risoluzione 
MIDI di 960 PPQN?

8. Quale canale, nello standard GENERAL MIDI, è riservato agli strumenti 
percussivi?

9. Quanti tipi di formati MIDI File esistono? Parlare brevemente delle loro 
differenze. 

10. Qual è il flusso di lavoro in Logic Pro X? 




